
Crash course 
in Office 365
Quick tips to save you time for your 
growing business
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Introduction
You and your team are likely some of the 1.2 billion 
people worldwide who have used Office 365. You’re 
familiar with standard apps like Word, Excel, Outlook, 
and PowerPoint. But when it comes to your business’s 
ever-changing needs and challenges, there’s more 
to Office 365 than meets the eye. From business 
intelligence programs to communication and 
teamwork solutions, advances in these productivity 
tools are changing the way we live and work. And 
whether your team’s concerns revolve around topics 
like security, mobile device management, or working 
remotely, a shift to the cloud can do more for your 
growing business than ever before.

In this e-book, you’ll learn how to make the best use 
of specific Office 365 apps across six critical areas of 
your business: mobility, teamwork, communication, 
security, productivity, and insights.
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Chapter 1

Mobility takes 
business out of 
the office
With premium versions of Word, Excel, and PowerPoint, along with a user 
interface optimized for Android or iOS phones or tablets, Office 365 lets your 
team perform at their best, whether in or out of the office.



“We hear from millennials that 
flexible working is a high priority. 
And we believe that when you 
respect individuals for who they 
are and how they operate, it 
increases productivity significantly. 
By giving employees Office 
365 cloud-based components, 
we’re able to create a more fluid, 
flexible approach to the physical 
workplace.”

Carl Dawson
IT Director, Marks & Spencer
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Word

Add comments in 
Word via your phone
Need to give feedback to a colleague while 
commuting? Edit documents on your Android or 
iPhone with the Word mobile app.

To add comments.
Tap anywhere in a document, then click Edit.

Type your comments. If this is your first time adding 
a comment, you’ll be asked to enter a username so 
other people know who edited the document.

Mobility takes business out of the office
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Excel

Four team-friendly 
Excel shortcuts
Think Excel is a desktop-only program? Think again. 
You can do just about everything in Excel on your 
smartphone or tablet.

1. Formulas
Calculate formulas on the mobile app by tapping the 
Formulas tab

2. Easy access to your files
Save Excel files to OneDrive and access them quickly 
on any device.

3. Built-in keyboard
Add formulas with ease with your tablet’s onscreen 
keyboard.

4. Recommended charts
Quickly visualize data with a few taps of a finger with 
the Recommended Charts feature, perfect for smaller 
screens.

Mobility takes business out of the office
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PowerPoint

Mobile PowerPoint 
has its perks
Prep and present on the go
Need to fix something on the way to a presentation? 
Use the PowerPoint app to make changes from your 
smartphone or tablet.

Keep notes at your fingertips
Read presentation notes directly from your phone.

Cut the cords
No need for bulky laptop cords and cables. Presenter 
View gives you full control over what your audience 
sees, showing speaker notes only on your tablet. 
New ink, laser pointer, and highlighting features help 
emphasize key concepts as you present.

Know your talking points
Ink your notes to help emphasize key points.

Mobility takes business out of the office
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OneDrive

Sharing made easy
OneDrive enables effortless access to files, so you 
can work from anywhere and share your work with 
your team, wherever they are. Preview more than 270 
common file types, including PDFs, Photoshop PSDs, 
Illustrator AIs, Visio files, DICOM medical images, and 
more. Even stream video on demand without waiting 
for it to download.

Confidently share your files knowing others will be 
able to access them seamlessly and securely. Share a 
file or folder with specific people or send a link that 
gives access to anyone who needs it, inside or outside 
your organization. In addition, you can control how 
long a link provides access, and you can easily view 
and modify permissions you have granted.

Mobility takes business out of the office
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Microsoft Teams

Communicate in real 
time
For the increasing number of organizations that can’t 
always get everyone in the same room, Teams provides 
a rich and immersive meeting experience where 
workers can add Office files—such as PowerPoint 
documents with animations—via desktop or mobile 
for calls or chat.

Mobility takes business out of the office
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Sway

Create beautifully on 
the go
Sway makes it quick and easy to create and share 
polished, interactive reports, presentations, personal 
stories, and more, all from your mobile device. Add 
your content, and Sway does the rest.

Create quickly
•	 Start a Sway from photos on your mobile device.
•	 Start a Sway by choosing a template.
•	 Access your content anywhere, and continue to 

edit your previous Sways while on the go.

Work on Sways with others with minimal effort
•	 Coauthor with others near you using your iPhone.
•	 Share an edit link with anyone to give them access 

to the Sway on their mobile or desktop device.

Easily add content
Use any photos or videos from your mobile device.

Share with ease
Every Sway is integrated with mobile share options. 
Just send a link to someone—they’ll be able to view 
your creation without signing up or downloading 
additional software.

Mobility takes business out of the office
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Yammer

Connect top to 
bottom
Yammer allows you to bring your whole workforce 
together—from the CEO to the firstline—to engage, 
share, and drive transparency, no matter where you are 
in the organization or the world.

With Office 365, you and your team are ready to go wherever your work takes you.

Mobility takes business out of the office
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Chapter 2

Working 
together 
works
Teams enables workers to collaborate from start to 
finish. Employees can share meeting notes, 
collaborate with proximity sharing, coauthor 
documents in real time, get updates, and access 
files—so nobody misses a beat.
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Coauthoring with confidence
Teamwork is a key component of Office 365, and the real-time coauthoring feature gives team 
members the chance to easily share ideas and add comments directly to a document. Improved 
version history lets you see, accept, or reject changes as well as revert to previous versions, ensuring 
nothing is lost. And new features improve the experience of working on a presentation in real time 
with multiple team members.

Working together works
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Word

Coauthoring with confidence

Get up and running
To get started using real-time coauthoring, save your Word document to OneDrive. Then click the 
Share button, located in the upper right of the window—the sharing experience is the same whether 
you share on the web, in Explorer on Windows 10 or Windows 7, or in Finder on Mac.

Invite colleagues
You can share and collaborate on files with people inside and outside your organization—even with 
people who don’t have an Office 365 subscription.

Working together works
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Enable real-time coauthoring
When your teammates sign on and work in the 
document in Word or Word Online, you’ll see their 
changes as soon as they’re made.

Work together seamlessly
You and your team can draft, comment, and edit work 
in real time. Add or reply to comments next to the text 
you’re discussing so your colleagues can follow the 
conversation.

Working together works
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Excel

Coauthoring with 
confidence
See document history at a high level
Open the History pane by clicking File > History. See 
at a glance when the file was created and when it was 
last modified.

See who contributed to a file
All revisions are listed by date and include the names 
of the people who made them, so you can follow up 
with anyone about their changes.

See how files evolve over time
Click on a version to open it and see how it differs 
from later versions of the same file.

Restore previous versions
If you want to revert to an older version of a file, just 
hit Restore and the document will revert to how it 
appeared at that point in time.

Working together works
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PowerPoint

Coauthoring with 
confidence
Get team visibility
The upper-right corner of the screen shows you who is 
working in the file and where they are working. With 
one click, you can jump to the slide they’re working 
on.

Initiate video chats
By clicking on a person’s thumbnail image and the 
Skype logo, you can start a group chat to discuss 
whatever you’re collaborating on.

View document activity
The activity feed shows you a full history of changes 
made to the document, letting you revert to prior 
versions if necessary.

Communicate through comments
Threaded conversations and quick-access buttons let 
you quickly reply to or resolve comments.

Working together works
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Outlook

Tips for sharing 
attachments
Outlook 2016 makes sharing files easier with 
an improved attachment experience.

Upload attachments for easy sharing
You can send files as traditional attachments 
or upload them right from Outlook to 
OneDrive or a SharePoint team site, letting 
everyone access, view, and edit the same 
version.

Choose from recently accessed files
When attaching a file to an email, you’ll see 
a list of all the documents you’ve recently 
accessed—so you can spend less time 
searching for the right one to attach.

Microsoft Teams

Two ways to 
collaborate 
smarter with Teams
Teams simplifies communication, with calling, 
meetings, and chat all in one place.

1. Chat with all project collaborators at 
once
You can initiate a call or video from Teams.

2. Don’t miss an opportunity to chat with a 
guest
Now you can safely and securely invite guests 
to Teams and have them join a chat, join a 
meeting, or participate in a call.

Working together works
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SharePoint

Two things to get you excited about 
SharePoint
Whether you’re teaming up on a new product strategy, a sales presentation, or a key company 
initiative, SharePoint keeps content at the center of teamwork. Files, sites, and content are easily 
shareable and accessible across teams and organizations.

1. Connect your workplace
SharePoint delivers connected experiences 
that empower people to share their expertise 
and work together with the files, data, 
conversations, and notes they need.

Start your day on SharePoint’s home page, 
where you can see, at a glance, the recent 
activity of your teams. Get to work quickly with 
easy navigation to your sites, and get a view of 
what’s important now.

2. Share and work together
When you add SharePoint pages as tabs in 
Teams, you can link news articles or your 
team site’s home page. More integration 
between SharePoint and Teams means more 
accessibility options for your workforce.

How to add SharePoint with 
Teams

1.	 In your Microsoft Teams channel, click + to 
add a tab.

2.	 Select SharePoint.
3.	 Select the relevant site or use a SharePoint 

link.
4.	 If you use a SharePoint link, give it a user-

friendly name for the Teams tab OneNote.

Working together works
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Coauthoring is brainstorming 2.0
During a meeting, contributors can type up brainstorming ideas in a shared OneNote document at 
the same time. Need to follow up with someone about an idea? Edits are always attributed to a writer, 
making it easy to find out who wrote what.

Sway

Coauthor smarter with proximity sharing
With the Sways Near Me feature, two people who are together can instantly start coauthoring in the 
same Sway. Just invite a collaborator from a list of nearby Sway users and send a sharing invitation. 
Your team member can then edit that Sway along with you—all from within the Sway app. Together, 
you can easily incorporate mobile captures—such as photos and videos from your mobile device—for 
on-the-go coauthoring on conference trips, customer site visits, and much more. Sways Near Me only 
requires a Wi-Fi or Bluetooth connection, so it works from anywhere in the world.

With iOS sharing capabilities, you can also share your Sway directly from an iPhone or iPad to an 
email, text message, social media post, or OneNote notebook, making your beautifully designed 
interactive presentations beautifully shareable.

Working together works
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Yammer

How Yammer brings 
your business 
together
Yammer is the best tool for connecting across your 
organization to solicit ideas and share best practices 
for broader initiatives.

Want to bring your team together in one virtual 
location?
Create groups that can gather diverse ideas regardless 
of time zones, geographies, or hierarchies.

Want to cross-collaborate and innovate?
Yammer provides a platform for empowering people 
to work together, use their collective knowledge to 
solve problems, and make better decisions, faster.

Want to measure progress?
Track and evaluate the progress of your team to 
help build momentum with new members and gain 
additional executive support.

With Office 365, everyone who needs to know is in the know.

Working together works
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Chapter 3

Communication 
is king
Effective communication strategy is at the heart of any successful team. From 
initiating a one-on-one dialogue to driving a team meeting, Office 365 gives 
your workforce control over their conversations, so they feel connected 
wherever they are.



“With the new meeting and voice 
services, Office 365 becomes richer 
and more full-featured. It gives 
us a super-simple collaboration 
environment for interacting with 
one another across a globally 
dispersed company. The better 
we communicate, the better we 
perform as a company.”

Jason Sele
IT Director, Zetec
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Microsoft Teams

Teams puts you in the 
driver’s seat
Before a meeting
Before a meeting, you can share files in the channel to 
prepare. The meeting itself can be held in a channel 
so the full context is brought into the meeting 
experience.

During a meeting
During a meeting, people can jump in and out of the 
discussion. Participants can chat, share their screens, 
and share files. The meetings experience is rich and 
immersive, and team members can add PowerPoint 
files with animations whether they’re joining via 
desktop or mobile. Teams also supports high-fidelity 
images of meeting participants.

After a meeting
After a meeting, the team can share a recap and 
follow-up actions in the channel either as part of the 
conversation thread or in the Wiki or OneNote.

Communication is king
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Network administrators can 
email the entire company from 
the All Company group, a default 
aggregation that automatically 
includes everyone.

PRO TIP

Yammer

Four ways to use the 
Office 365 internal 
social network
1. Announce to the group
The Announcement feature is a perfect way to share 
information with a wide range of people at once. 
Group members will see it in two places: their home 
feeds and inboxes.

Communication is king
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2. Share files across your organization
From Yammer, you can easily upload or share files 
across the suite, including SharePoint, OneDrive, 
Outlook, and Stream.

Communication is king

When you share video straight 
from Stream to Yammer, it will 
play right within your Yammer 
group feed.

PRO TIP
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3. Share a conversation
When you want to embed a Yammer conversation 
in your live broadcast or SharePoint communication 
site, you can post it to a group or send it as a private 
message and bypass the group page altogether.

Communication is king

At the top of the thread, Yammer 
displays the number of times the 
conversation has been shared.

PRO TIP
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4. Create a poll
Use Yammer to crowdsource feedback or get a quick 
pulse on your business.

Communication is king

Yammer recalculates the 
percentage of responses, so the 
numbers are updated every time 
the group page is refreshed.

PRO TIP
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Communication is king

Six tips and tricks for using Groups

1. Bring your team together around a project with 
a shared inbox, calendar, document library, OneNote 
notebook, and planning tool, all with just a few clicks 
within Outlook.

2. Facilitate quick referencing and easy 
communication by accessing messages organized by a 
thread.

3. Tag colleagues with the @mention feature when 
their input is needed.

4. Continue conversations on the go via Groups on 
the mobile app.

5. Initiate voice and video calls via the Teams plug-
in.

6. Access conversations online for groups marked as 
a “favorite.”

Outlook

Connect and share from Outlook
The Groups feature elevates team communication by putting everything related to a project in one 
place. From Outlook, sets of users can connect, schedule meetings, share common calendars and 
files, and take notes.
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With Office 365, you can control the conversation across your organization.

Sway

Communicate with style
Transform your presentations to communicate beautifully. With Sway’s built-in design engine, you 
don’t need to worry about having a design degree to quickly make and share polished, interactive 
presentations and reports that drive engagement and, ultimately, results.

Create quickly
•	 Start from a Word, PowerPoint, or PDF file.
•	 Start by choosing a template.
•	 Start by typing a topic.

Add a variety of content from multiple 
sources
•	 Content: photos, videos, audio, embeds
•	 Sources: suggested, OneDrive, Flickr, Bing, 

Pickit, YouTube, your device, and many 
more

Designs
Sway automatically designs beautiful outputs 
and allows you to style based on your 
company colors.

Easy to share
All you need is to send a link. Sways look 
great on any device size (mobile or desktop), 
without any additional effort on your part.
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Chapter 4

Technology 
drives 
efficiency
Productivity happens when your apps and teams are 
able to work together seamlessly and effortlessly. 
From editing in Word to sharing with your 
coworkers, you’ll be able to manage and collaborate 
on shared documents securely and without 
interruption. When all your tools are talking to each 
other, it makes it easy for you to work on projects in 
real time with your team, no matter where you are.
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Word

Tell Me feature
In Word 2016, use the Tell me what you want 
to do field on the ribbon to enter words and 
phrases about what you want to do next, then 
quickly navigate to features you want to use or 
actions you want to perform.

You can also use the Tell Me feature to help 
you find what you’re looking for, or use Smart 
Lookup to research or define the term you 
entered.

Excel

One-click 
forecasting
The forecasting function now enables 
forecasting based on Exponential Smoothing 
(such as FORECAST.ETS).

In the Data tab, click the Forecast Sheet 
button to create a forecast visualization of 
your data series.

From the wizard, you can also find options to 
adjust common forecast parameters, such as 
seasonality, which is automatically detected by 
default and confidence intervals.

Technology drives efficiency

The top time-saving features in 
Word and Excel
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SharePoint

Streamline your 
process
Free yourself and your team from spending time on 
recurring manual processes. Now you can build and 
launch Flows directly from OneDrive to automate 
processes for your files, or directly from SharePoint to 
power everything from simple alerts and approvals to 
the management of complex, mission-critical business 
operations. Simply click Add Flow, then select a flow 
template from a panel.

Start with features like these:

1. Gather and manage data and files
SharePoint lists collect data—just like you might 
in Excel—and are easy to share and manage on an 
intranet. More than 10 million custom lists are in use 
across Office 365—from simple lists like contacts 
and tasks to lists that power mission-critical business 
operations for large enterprises. Use PowerApps to 
build custom forms to view, create, and modify data 
and files.

Technology drives efficiency
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2. Automate repetitive tasks
Use the simple, visual designer in Flow to lay out the 
steps for recurring manual team and organizational 
processes. You can do everything in Flow—from 
configuring alerts and approvals to modeling complex, 
multistage processes.

3. Connect to and integrate data sources and 
services
When your process needs data from other sources 
and services, Flow lets you automate data exchange, 
synchronize files, and more. For example, use Flow to 
copy information entered by a sales team in Microsoft 
Dynamics to a SharePoint list used by operations. 
Flow also integrates with on-premises and third-party 
services.

4. Build apps that transform your business
With PowerApps, without writing code, you can 
create apps that interact with data in SharePoint lists 
and libraries, as well as other cloud and on-premises 
sources. Use PowerApps to create digital experiences 
that take advantage of technology, like cameras on 
mobile phones, to work in innovative ways.

Technology drives efficiency
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OneNote

Never miss a note
Taking notes on every important part of a meeting can 
be a little overwhelming. With OneNote 2016, you can 
invite others to a shared notebook by choosing File > 
Share > Invite People. To share a notebook during a 
meeting, choose File > Share > Share with Meeting.

After others in your team open the notebook, 
anyone with permissions can add meeting notes 
simultaneously, which then sync automatically.

Technology drives efficiency

With Office 365, work together seamlessly and effortlessly with better technology.
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Chapter 5

Protect 
your data
What does it mean to be the most secure Office 365 
ever? Whether you’re a team of five or a Fortune 
500, you’ll get enterprise-level security to keep out 
hackers and viruses and ensure your data remains 
confidential.



“We’re making a huge leap 
forward in our ability to support 
global teamwork, without 
sacrificing security and data 
privacy, by adopting the Microsoft 
Office 365 suite of cloud 
productivity services. Office 365 
meets both our mobility needs 
and our security standards.”

Bryan Ackermann
Senior Vice President and Chief Information Officer, 
Korn Ferry
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Industry compliance
Office 365 email automatically adheres 
to 10 privacy compliance standards in 
various industries. Microsoft also offers 
robust contractual data privacy and security 
commitments by default to help customers 
comply with local regulations. The Online 
Services Terms contract document includes 
the EU Model Clauses, UK Data Protection Act, 
and many other provisions. It applies as soon 
as customers accept the Microsoft license 
agreement.

Data privacy and access visibility
Microsoft’s commercial online services do not 
capture, maintain, scan, index, share, or use any 
data-mining technology. This means your email 
will never be scanned for ad-serving purposes, 

nor will the data you store with us be read or 
unknowingly shared with third parties in any 
way. You’ll also benefit from fully customizable 
controls that enable you to tailor enterprise-
grade security service to best meet your 
company needs.

Security against hackers and viruses
Even if your company has a security team, it’s 
nearly impossible to assemble one large enough 
to uncover and protect against the hundreds 
of possible alerts that come through each day. 
With Office 365, an enterprise-level extension 
of your security team is focused on the physical 
security of your datacenters, the logical security 
level applied to hosted machines, and the data 
security level protecting your data at rest and 
during transmission.

Protect your data

Protect your data
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Exchange

No need for virus-scanning software
Email is the gateway in and out of your organization. Prioritize security across the board with 
protection from external threats, and defend with internal access controls.

•	 To deal with external threats and unknown risks, Exchange Online Advanced Threat Protection 
comes included in Office 365 and helps secure mailboxes against sophisticated attacks in real 
time, eliminating the need to install additional virus-scanning software. Every email attachment 
or link that passes through your Exchange server is automatically evaluated for suspicious activity, 
and malicious content is neutralized before an attack can occur.

•	 To protect internal information, Exchange allows your administrators to control email access 
permissions using information rights management (IRM) by keeping unauthorized people from 
printing, forwarding, or copying sensitive information. Data loss prevention (DLP) through Office 
365 enables administrators to control transport rules, actions, and exceptions without affecting 
mail flow.
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SharePoint

A trusted platform for teamwork
SharePoint is designed to create a fluid teamwork experience that transcends boundaries while 
protecting your organization, data, and employees with enterprise-level security across Office 365 
and devices.

Three aspects of SharePoint security

1. Industry-leading protection for your information
SharePoint and OneDrive make you confident about the security of your data by providing the 
safest space in the cloud. To help ensure your data is safe and your team is working in a secure 
environment, these services work to authenticate and authorize users, protect content, and secure the 
infrastructure.

2. Manage security more easily with intuitive and advanced controls
SharePoint and OneDrive include a set of controls to help keep your data safe no matter where 
mobile users access or share data, what device they’re working on, or how secure their network 
connection is.

3. Stay in the know with insights and intelligence
SharePoint and OneDrive offer advanced auditing capabilities to help you discover forensic 
information about specific activities conducted by a user or an administrator.

Protect your data
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Use mobile device management for Office 
365 to secure and manage the following 
types of devices:

•	 Android 4 or later versions
•	 iOS 7.1 or later versions
•	 Window 8.1
•	 Windows Phone 8.1
•	 Windows 8.1 RT
•	 Windows 10
•	 Windows 10 Mobile

Mobile device management protects a range 
of Office 365 products, including:

•	 Exchange
•	 Excel
•	 OneDrive
•	 Outlook
•	 PowerPoint
•	 Sway (iOS only)
•	 Word

Mobile device management
What happens if a device loaded with company data is lost or stolen? That’s where mobile device 
management from Office 365 comes in. It allows administrators to prevent unauthorized user 
access by setting up policies that ensure company email and documents can be accessed only on 
phones and tablets within your Office 365 service. If a device loaded with Office 365 is lost or stolen, 
administrators can wipe the device clean.

Office 365 worries about threats to your data so you don’t have to.
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Chapter 6

Unleash 
the power 
of data
From customer-generated data to the data around 
how your team works, information surrounds your 
business. Within it are insights waiting to be 
discovered and harnessed to transform your 
business and your bottom line.

With the insight-centric apps of Microsoft Office 
365, you can analyze then visualize data in beautiful 
presentations and compelling visuals that can be 
shared among your team.
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Unleash the power of data

Power BI

The potential of a single database

Gather results in 15 seconds or less
A single set of data is all you need to begin using Power BI. From the Datasets section in the left 
pane, select the ellipses you’re interested in analyzing. From the menu of options, select Quick 
Insights. After a mere 15 seconds, your insights will be ready. Click View Insights. From there, you 
have a couple of options:

•	 Pin visuals to a dashboard.
•	 Filter for additional insights.
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Unleash the power of data

Ask questions to glean insights
Power BI is equipped with a powerful language-recognition engine that will generate reports and 
visualizations from specific questions you ask.

•	 Start at the dashboard for the dataset you wish to analyze.
•	 Enter a question using natural, conversational language (e.g., “What was our revenue in 2016?”). 

A list of suggested terms will appear based on your question.
•	 Click on a term to see results and a corresponding visual.
•	 Save the visual to the dashboard by selecting the pin icon next to the question input box.

Collect your insights in a dashboard
It only takes one pinned visual to create a dashboard. Once you’ve started to build a dashboard full of 
insights around a particular dataset, you can rearrange the layout.

•	 Resize a tile by dragging its handles in or out.
•	 Move a tile by simply clicking and dragging it to where you want it to live on your dashboard.
•	 Change the title or subtitle by hovering over a tile, clicking the pencil icon, and opening the tile 

details.
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Delve

Smart insights help you work smarter
Delve Analytics shows you how you and your team can work more efficiently.

Network
•	 Which individuals do you interact with the most?
•	 How quickly do you respond to their emails?

Email
•	 How quickly do you read and respond to your emails?
•	 What are your average email read rates and response times?

Focus hours
•	 How often have you had at least two hours to focus?
•	 How can you find more time to focus?

Meetings
•	 How many hours have you spent in meetings this week?
•	 How effective are they?

Unleash the power of data

With Office 365, data insights help you work smarter for a better bottom line.



Crash-course finish line

Scaling for success starts with the right 
business apps to get the work done. Better 
work is possible if you equip your business 
with apps that promote mobility, teamwork, 
communication, security, productivity, and 
insights.

Now that you’ve completed the Office 365 crash 
course, it’s time to take a closer look at exactly 
what Office 365 can do for your organization.

See plans and pricing for Office 365
Get started with a free trial of Office 365
Learn more about Microsoft 365

https://products.office.com/business/office-365-business-premium
https://go.microsoft.com/fwlink/p/?linkid=510938
https://discover.office.com/discover-microsoft-365/

